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Executive Summary

This technical whitepaper describes the procedure for using the HP Integrated
Device Drive Kit during the unattended installation of Microsoft Windows. This is an
overview of the tools and steps needed to support a bare-metal installation of
Windows 7 on HP business desktops. This whitepaper provides examples of the
following:

o Deploying Microsoft Windows 7 using a network infrastructure

o Deploying Microsoft Windows 7 using installation media DVDs

Finally, this paper also provides tips and best practices for using the following:

e Microsoft Deployment Toolkit 2010

e Windows Automated Installation Kit

Introduction

Managing operating system images and hardware driver configurations has
become a key activity for IT professionals. In enterprise environments, it can be a
complex and time-consuming process as the IT professional needs to:

e Manually select and repackage the appropriate hardware drivers for the
remote imaging environment

e Be able to deploy the drivers to the correct set of systems for keeping the
environment stable and reliable
The HP Integrated Device Driver Kit, along with Microsoft Deployment Toolkit 2010
(MDT 2010) and the Windows Automation Installation Kit (WAIK) provide multiple
solutions to help IT professionals deploy Windows 7 with HP-tested and -qualified
drivers. This process and combination of tools streamline OS deployments and
simplify the IT imaging process.
MDT 2010 provides a common console with the comprehensive tools and
guidance needed to efficiently manage the deployment of Microsoft Windows 7.
MDT 2010 is the recommended process and toolset to automate desktop
deployments of Microsoft Windows.

Benefits

e This is an improved OS deployment experience with shortened image
deployment timelines.

e The HP-ested drivers are structured for the unattended installation of Windows.

e This convenient package contains the hardware-enabling drivers for each
supported PC model.

o ltis a free solution from HP.



Prerequisites

Deployment Using a Network

To deploy operating systems using a network, the following software components
are required:

Microsoft Deployment Toolkit 2010 (MDT 2010) — Download
Windows Automated Installation Kit (WAIK) version 2.0 — Download
Windows PowerShell v2.0 — Download

Device drivers required for the target computer

Device drivers required for the reference computer

Note:

Windows PowerShell 2.0 is distributed as part of the
Windows Management Framework Core from Microsoft.

Deployment Using Removable Media

To deploy operating systems using removable media, the following components are
required:

Windows Automated Installation Kit (WAIK) version 2.0 — Download
Device drivers required for the target computer

Device drivers required for the reference computer


http://technet.microsoft.com/en-us/solutionaccelerators/dd407791.aspx
http://www.microsoft.com/downloads/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en
http://support.microsoft.com/kb/968929
http://www.microsoft.com/downloads/details.aspx?familyid=696DD665-9F76-4177-A811-39C26D3B3B34&displaylang=en

Technician’s Computer

The technician’s computer must meet the following specifications:

Operating System: Windows Vista or later

Processor: 1.4 gigaheriz (GHz) or faster
Memory: 1GB or more physical memory
Hard Disk Space: 16GB or more available disk space
Optical Drive: CD/DVD-ROM drive

Target Computer

The target computer must meet the following specifications:

Processor: 1.4 gigaheriz (GHz) or faster
Memory: 1GB or more physical memory
Hard Disk Space: 16GB or more available disk space

Deploying Microsoft Windows 7 over a Network

In this scenario, we demonstrate the general framework used to create and deploy
an image of a Windows 7 using a network. This process, known as image-based
deployment, is ideal for high-volume environments in which speed is a priority.
Using this method, you create and deploy the image using the MDT 2010
Deployment Workbench and LiteTouchPE, a modified version of Windows PE. The
Deployment Workbench provides imaging technology to capture and apply the
Windows installation. LiteTouchPE provides a stand-alone pre-installation
environment, including network connectivity and disk configuration.

For corporate deployments, using an image-based deployment over a network
ensures faster and consistent installations across all systems. This scenario is a
simple network solution. HP also offers very sophisticated solutions for deploying
new operating systems, such as Windows 7, to a large number of devices: HP
Client Automation. Other more advanced deployment solutions using management
servers are discussed under Additional References.

The following process guides you through a Lite-Touch Installation (hereafter referred
to as LTl) deployment, which is automated to a nearly Zero-Touch Installation. This
process assumes that:

e You are installing to a machine with no operating system.

o The installation does not include any user or application migration information.



The following diagram illustrates the deployment process.
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Figure 1: Network deployment model

In this section, we create a New Deployment Share inside the Deployment
Workbench.

1.

Click Start > All Programs -> Microsoft Deployment Toolkit > Deployment
Workbench.

In the Deployment Workbench console tree, select Deployment Shares. In the

Actions pane, click New Deployment Share.

The New Deployment Share Wizard starts. Perform the following steps to create

the new deployment share:

a. Path — Specify the location of the deployment share as
C:\Deploymentshare$ and then click Next.

b. Share — This is automatically set; click Next.

c. Descriptive Name — Keep the default name and click Next.

d. Allow Image Capture — When performing a new computer (bare metal)
deployment info a workgroup, the deployment wizard normally asks if an
image should be captured. This step can be skipped if it is not required.

(Captures of domain-joined machines are not recommended.) Clear the
Ask if an image should be captured check box and then click Next.



e. Allow Admin Password — During deployments, users can be prompted to
set the local Administrator account password. In some situations, you may
wish to prevent the local user from accessing the local Administrator's
account for security reasons. For this example, keep the default setting and
click Next.

f. Allow Product Key — During deployments, users can be prompted to specify
an installation or activation product key. In some situations, you may wish
to prevent this. For this example, keep the default setting and click Next.

g. Summary - Click Next.
h. Progress — No user interaction is required.
i. Confirmation — Click Finish.

The New Deployment Share Wizard finishes and the new deployment share—
MDT Deployment Share (C:\DeploymentShare$)—appears in the Details pane.

In this step, we import the Windows 7 DVD contents.
1. Insert the Windows 7 DVD into the DVDROM drive.

2. In the Deployment Workbench console tree, expand the MDT Deployment
Share (C:\DeploymentShare$) and select Operating Systems. In the Actions
pane, click Import Operating System.

The Import Operating System Wizard starts.
3. Perform the following steps to import the operating system:

a. OS Type — Select Full set of source files and then click Next.

b. Source — Specify the location of the DVDROM drive and then click Next.
c. Destination — Keep the default location and then click Next.

d. Summary - Click Next.

e. Progress — No user interaction is required.

f.  Confirmation — Click Finish.

The Import Operating System Wizard finishes and the imported operating
system—Windows 7 ENTERPRISE in Windows 7 x86 install.wim—appears in
the Details pane.

Note:

The operating system name may be different depending
on the version you imported.



In this step, you import the network drivers for the LiteTouchPE disc. These drivers
are incorporated into the LiteTouchPE to provide networking capability, without
which your deployment does not work. In Additional Configurations, step 8, we
add our entire driver collection to a share folder. Putting the driver collection in a
share folder adds more flexibility.

Note:

Ideally, you should consolidate your network drivers in a
single location and run this process once. Otherwise, you
have to browse to and select each additional folder
containing network drivers (step 2a).

1. In the Deployment Workbench console tree, under the expanded MDT
Deployment Share (C:\DeploymentShare$), select Out-of-Box Drivers. In the
Actions pane, click Import Drivers.

The Import Driver Wizard starts.
2. Perform the following steps to import the network drivers:

a. Specify Directory — Select Browse, locate the directory from which you
extracted the HP Integrated Device Drive Kit and then select the folder
containing the network drivers.

b. Summary — Click Next.
c. Progress — No user interaction is required.
d. Confirmation — Click Finish.

The Import Driver Wizard finishes and the imported drivers appear in the
Details pane.

In this step, we create a task sequence for deploying Windows 7.

1. In the Deployment Workbench console tree, under the expanded MDT
Deployment Share (C:\DeploymentShare$), select Task Sequences. In the
Actions pane, click New Task Sequence.

The New Task Sequence Wizard starts.
2. Perform the following steps fo create the task sequences:

a. General Settings — Task sequence ID: MDTOO1, Task sequence name:
Windows 7 Enterprise x86, Task sequence comments: Windows 7
Enterprise Install, and click Next.

b. Select Template — In the Select Template list, click Standard Client Task
Sequence click Next.

c. Select OS — In Windows 7 x86 install.wim, select Windows 7 ENTERPRISE
(the name may be different, depending on the version you imported in
Importing Operating Systems) and then click Next.

d. Specify Product Key — Keep the default setting Do not specify product key
at this time (the Windows 7 setup DVD automatically assigns a product
key) and then click Next.



e. OS Settings — Full Name: <enter full name>, Organization: <enter your
organization>, Internet Explorer Home Page: <your organizations home
page>, and then click Next.

f. Admin Password — Select Do not specify an Administrator password at this
time. The local Administrator password is provided in this task sequence,
so it is not needed. Click Next.

g. Summary — Click Next.
h. Progress — No user interaction is required.
i.  Confirmation — Click Finish.

The New Task Sequence Wizard finishes and the new task—Windows 7
Enterprise x86—appears in the Details pane.

In this step, we describe the configurations necessary to automate the LTl
deployment process. There are two main configuration files: Bootstrap.ini and
CustomSettings.ini. Also, we create some additional folders to store the remaining
drivers and installation logs.

1.

In the Deployment Workbench console tree, select MDT Deployment Share
(C:\DeploymentShare$). In the Actions pane, click Properties.

The MDT Deployment Share (C:\DeploymentShare$) Properties window opens.

Select the Rules tab and click the Edit Bootstrap.ini button in the lower right
corner.

The Bootstrap.ini opens in Notepad.

The following settings are necessary to locate (DeplyRoot) and connect (UserID,
UserDomain, and UserPassword) to the network share. Ideally, you should
create a separate local account with access to the Deployment Share.

bootstrap.ini

[Settings]
Priority=Default

[Default]
SkipBDDWe lcome=YES

DeployRoot=\\<machine name>\DeploymentShare$
UserliD=<local user account>

UserDomain=<machine name>
UserPassword=<local user account password>



4. Save and exit Bootstrap.ini.

Note:

The Bootstrap.ini is compiled into the LiteTouchPEx86.iso.
Any changes to the Bootstrap require a Deployment Share
update. We explain this later in Update Deployment
Share and Create LiteTouchPE Disc.)

5. Now edit the settings in the Rules tab as follows: (These settings are for the
CustomSettings.ini and are necessary to automate the LTI deployment.)

CustomSettings.ini

[Settings]
Priority=Default
Properties=MyCustomProperty

[Default]
OSInstal I=YES
WipeDisk=TRUE

UserlID=<local user>
UserDomain=<machine name>
UserPassword=<user password>

SkipBDDWe lcome=YES
SkipApplications=YES
SkipAppsOnUpgrade=YES
SkipProductKey=YES

SkipDeploymentType=YES
DeploymentType=NEWCOMPUTER

SkipDomainMembership=YES
JoinWorkgroup=WORKGROUP

SkipUserData=YES

UDD IR=%Computername%

UDShare=\\<machine name>\DeploymentShare$\USMT
UserDatalLocation=NONE

SkipCapture=YES
ComputerBackupLocation=NETWORK

SkipComputerBackup=YES
BackupDi r=%Computername%

BackupShare=\\<machine name>\DeploymentShare$\Captures

SkipTaskSequence=YES



TaskSquence ID=MDT001

SkipBuild=YES
BuildI1D=MDTO001

SkipLocaleSelection=YES
KeyboardLocale=0409:00000409
UserLocale=en-US
UlLanguage=en-US

SkipTimeZone=YES
TimeZoneName=Central Standard Time

SkipAdminPassword=YES
AdminPassword=<complex password>

SkipComputerName=YES
0OSDComputerName=%Ser ialNumber%

SkipBitLocker=YES
BDEInstal 1Suppress=YES

SkipFinalSummary=YES
SkipSummary=YES

SLShare=\\<machine name>\DeploymentShare$\Logs

DriverPathsl=\\<machine name>\DeploymentShare$\Drivers

Now click Apply and then click OK to save the updated settings in
CustomSettings.ini.

The CustomSettings.ini and Bootstrap.ini can be located in the

C:\DeploymentShare$\Control folder.

Create a Logs folder in the root of the deployment share
C:\DeploymentShare$\Logs to store the logs from deployed machines. This
value is set in the CustomSettings.ini as:

SLShare=\\<machine name>\DeploymentShare$\Logs

Create a Drivers folder in the root of the deployment share
C:\DeploymentShare$\Drivers and extract the HP Integrated Device Driver Kit
to this folder. You can also add any additional drivers you have to this folder.
This value is set in the CustomSettings.ini as:

DriverPathsl1=\\<machine name>\DeploymentShare$\Drivers

10



In this step, you update the deployment share and generate the LiteTouchPE ISOs.

1. In the Deployment Workbench console tree, select MDT Deployment Share
(C:\DeploymentShare$). In the Actions pane, click Update Deployment Share.

The Update Deployment Share Wizard starts.

2. Perform the following steps to update the deployment share and create the
LiteTouchPE disc:

a. Options — When updating the deployment share, the latest tools are
copied to the deployment share. If any changes have been made to the
boot image settings or to the content that needs to be included in the boot
image, those updates are also made. Keep the default setting, select
Compress the boot image contents to recover space used by removed or
modified content, and then click Next.

b. Summary — Click Next.
c. Progress — No user inferaction is required.
d. Confirmation — Click Finish.

3. After the Update Deployment Share Wizard finishes, browse to
C:\DeploymentShare$\Boot to see LiteTouchPE_x86.iso. Use a CDROM
burning application (i.e., Roxio, Nero, efc.) to create the LiteTouchPE disc.

In this step, you deploy Microsoft Windows 7 using LiteTouchPE and the
Deployment Workbench.

1. Insert the LiteTouchPE disc into the computer and turn the computer on.

2. Press F9 to go to the boot menu and select boot device CD/DVD-ROM. When
prompted Press any key to boot from CD or DVD, press a key.

LiteTouchPE launches and begins the installation process; all settings specified
are applied.

When Windows Setup is finished, the system logs in as administrator.

11



Deploying Microsoft Windows 7 Using Removable

Media

In this scenario, we describe using removable media to install Windows 7 onto a
new computer. This deployment method is sometimes known as bare-metal
installation or the DVD-boot method. These procedures guide you through an
unattended installation using an answer file rather than the standard Windows
Setup. This process is ideal for low-volume processes (such as IT test laboratories),
reimaging, and small organizations that need to configure only a few computers.

This process does not require a network.

The following diagram illustrates the deployment process.
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In this step, you set up your Windows System Image Manager (hereafter referred to
as Windows SIM) environment.

1. Click Start > All Programs -> Microsoft Windows AIK > Windows System

Image Manager.

2. In the Distribution Share pane, right-click Select a Distribution Share and then

select Create Distribution Share.

3. In the Create Distribution Share dialog box, browse to the folder in which you

want to create your Distribution Share and then click Open.
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Unzip the HP Integrated Device Driver Kit to the Out-of-Box Drivers folder in
which you created your Distribution Share.

On the technician computer, insert the Windows 7 product DVD.

Browse to the \Sources directory on your DVD-ROM drive and copy the
Install.wim and install_Windows[version].clg files from the Windows product
DVD to the computer.

On the Windows SIM File menu, click Select Windows Image.

In the Select @ Windows Image dialog box, browse to the folder in which you
saved Install.wim (in step 6). Select Install.wim and then click Open.

On the File menu, click New Answer File.

An empty answer file appears in the Answer File pane.

In this step, you define Windows Setup configurations and Windows Welcome
settings.

1.

In the Windows SIM Windows Image pane, expand the Components node to
display available settings and then expand it to the lowest child object.

2. On the expanded list of components, add the components in the table below to
your answer file by right-clicking the component and then selecting the
appropriate configuration pass.

This action adds the component to your answer file in the specified
configuration pass, or phase, of Windows installation.

Component Configuration Pass

Microsoft-Windows-International-Core-LiteTouchPE\ windowsPE

SetupUlLlanguage

Microsoft-Windows-Setup\DiskConfiguration\Disk\ windowsPE

CreatePartitions\CreatePartition

Microsoft-Windows-Setup\Imagelnstal \OSImage\InstallTo windowsPE

Microsoft-Windows-Setup\UserData\ProductKey (if needed) windowsPE

Microsoft-Windows-Shell-Setup specialize

Microsoft-Windows-International-Core oobeSystem

Microsoft-Windows-Shell-Setup\OOBE oobeSystem

Microsoft-Windows-Shell-Setup\UserAccounts\ oobeSystem

AdministratorPassword

Microsoft-Windows-Shell-Setup\UserAccounts\Local Accounts\ oobeSystem
LocalAccount\Password

All of the settings you added must appear in the Windows SIM Answer File
pane.
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3. Under Settings, select the appropriate settings (in the right column) and type
the appropriate value specified in the following table. To avoid receiving
validation warnings/errors, remove any unused child objects that have no
value assigned.

Configuration =~ Component Value
Pass
1 WindowsPE  Microsoft-Windows-International-Core- Inputlocale = en-US
LiteTouchPE Systemlocale = en-US
Ullanguage = en-US
Userlocale = en-US
1 WindowsPE  Microsoft-Windows-International-Core- Ullanguage = en-US
LiteTouchPE\SetupUlLanguage
1 WindowsPE  MicrosoftWindows- WillShowUI = OnError
Setup\DiskConfiguration
1 WindowsPE  Microsoft-Windows-Setup\ DisklD = 0
DiskConfiguration\Disk * WillWipeDisk = true
1 WindowsPE  Microsoft-Windows-Setup\ Extend = true
DiskConfiguration\Disk\CreatePartitions\ Order = 1
CreatePartition Type = Primary
1 WindowsPE  Microsoft-Windows-Setup\Imagelnstall\ InstallToAvailablePartition = false
OSImage WillShowUI = OnError
1 WindowsPE  Microsoft-Windows-Setup\Imagelnstall\ DiskiD = 0
OSImage\InstallTo PartitionID = 1
1 WindowsPE  Microsoft-Windows-Setup\UserData AcceptEula = true
FullName = <name>
Organization = <organization
name>
1 WindowsPE  Microsoft-Windows-Setup\UserData\ Key = <product key> (if needed)
ProductKey WillShowUI = OnError
4 Specialize Microsoft-Windows-Shell-Setup ComputerName = *

TimeZone = Central Standard Time

7 oobeSystem

Microsoft-Windows-Shell-Setup\OOBE

HideEULAPage = true
Networklocation = Work
ProtectYourPC = 1

7 oobeSystem

Microsoft-Windows-Shell-Setup\
UserAccounts \AdministratorPassword

Value = <password>

7 oobeSystem

Microsoft-Windows-Shell-Setup\
UserAccounts\LocalAccounts\LocalAccount

Description = <description>
DisplayName = <display name>
Group = Adminstrators

Name = <username>

7 oobeSystem

Microsoft-Windows-Shell-Setup\
UserAccounts\Local Accounts\LocalAccount
\Password

Value = <password>

14



Caution:

If Microsoft-Windows-Setup\DiskConfiguration\Disk
[WillWipeDisk = True], then the hard drive will be
formatted and all data will be lost.

In the Windows SIM menu, click Insert and then move the cursor over Driver
Path. Select Pass 2 offlineServicing.

In the Select a folder that contains driver files dialog box, browse to the folder
in which you extracted the HP Integrated Device Drive Kit and then click Open.

In the Answer File pane, verify or edit the path locations in the right column.

If you are using a UNC path, expand the child component PathAndCredentials
and then select Credentials. In the right column, type the appropriate value for
Domain, Password, and Username.

To add additional driver path locations, right-click Driver Path. Select Insert
New PathAndCredentials and repeat step 5.

Important:

If you have boot critical drivers, you must add your drivers
to Pass 1 WindowsPE or your installation could fail.

In this step, you validate the settings in your answer file and then save them to a

file.
1.

In Windows SIM menu, click Tools and then click Validate Answer File.

The setting values in the answer file are compared with the available settings in
the Windows image.

If the answer file validates successfully, the No warnings or errors message
appears in the Messages pane at the bottom of the Windows SIM window. If it
does not validate successfully, error messages appear in the Messages pane.

If an error occurs, double-click the error message in the Messages pane to
navigate to the incorrect setting. Change the setting to fix the error and then
validate again by clicking Validate Answer File. Repeat this step until the
answer file validates without warnings or errors.

On the File menu, click Save Answer File.

In this step, you create a configuration set on a USB flash drive.

1.
2.
3.

Insert a USB flash drive (UFD).
In Windows SIM menu, click Tools and then click Create Configuration Set.

In the Create Configuration Set dialog box, type the drive letter for the UFD and
then click OK.

Windows SIM now copies all necessary files to the UFD.
When all files have been copied, click OK.

15



In this step, we deploy an unattended Microsoft Windows 7 using the Windows
Setup disc and removable media.

1. Insert a USB flash drive (UFD) and the Windows product DVD into the
computer.

2. Press F9 to go to the boot menu and select boot device CD/DVD-ROM. When
prompted Press any key to boot from CD or DVD, press a key.
Windows Setup applies all settings specified in the answer file.

3. When Windows Setup is finished, you can make any additional customizations
and run tess.

Tips and Best Practices

In Additional Configurations, we cover the settings needed to automate the LTl
deployment. For more information on these settings, please click here to download
Microsoft Deployment Print Ready Documentation. Once you have downloaded the
zip file, extract the Toolkit Reference.docx for a full list of Property settings and

values (pages 57251).

In Additional Configurations step 8, we added a Drivers folder. You can have
multiple locations for drivers which would be set consecutively as DriverPathsT,
DriverPaths2, etc. These can be on any file share. This configuration allows you a
great deal of flexibility to add, update, and remove drivers without recompiling
your boot media.

In Building an Answer File, we discuss building an Answer File—two samples are
below. The first is a basic, unattended install with one partition. The second has two
partitions, one of which is hidden by setting Microsoft-Windows-
Setup\DiskConfiguration\Disk\ModifyPartitions\ModifyPartition TypelD=0x27.

x X

OnePartion_Sample_ | [TwoPartition_Sample
XML. pdf _XML. pdf

The above samples have a driver path set to %ConfigSetRoot%—this refers to the
root of the USB flash drive. You can add all drivers to the USB flash drive and the
system searches for the correct driver. Alternately, you can use UNC paths for a
more robust approach.

16


http://go.microsoft.com/fwlink/?LinkId=163310

A local user account must be defined in order to access the unattended build. For
security reasons, the system disables the administrator account after installing the
operating system.

nxn

Set this value to “*” and the system assigns a computer name automatically which
allows you to reuse the Autounattend.xml indefinitely.

Also worth mentioning is that by default the Administrator password is encrypted in
the autounattend.xml. The samples embedded above have PlainText set to “True” for
example only.

Windows Setup produces numerous log files that are useful for troubleshooting
installation. For more information about these log files, see Windows Setup Log File
Locations at http://support.microsoft.com/default.aspx/kb/927521.

Additional References

HP Client Automation greatly simplifies the entire Windows 7 migration effort:

o Identifies which devices in the environment are Windows 7-capable, based on
CPU speed, amount of memory, and free disk space

o Provides a complete inventory of all software being used (not just installed) by
all users

o Protects users’ data and personal settings while migrating to Windows 7

e Automatically acquires the latest versions (including Windows 7) of all
hardware drivers and HP-supplied applications for HP PCs

e Easily customizes the Windows 7 environment after installation.

More information is available at www.hp.com/qgo/clientautomation.

A Windows 7 migration demonstration video is available at
http://hpbroadband.com/program.aspx?key=012110CASWin7.

Another solution for large-scale OS deployment is Microsoft System Center

Configuration Manager (SCCM).

Deploying Operating Systems using Microsoft SCCM provides the tools needed to
create operating system images to be deployed to:

o Computers managed by System Center Configuration Manager

e Unmanaged computers using bootable media, such as a CD or DVD
The deployment image, a Windows Imaging Format (WIM) file, contains:
e The Windows operating system to be deployed

e Any applications that you need to install on the computer

System Center Configuration Manager is designed to be the primary means to
deploy operating systems for both server and client platforms.

17
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Another important deployment feature of System Center Configuration Manager is
the integrated Task Sequencer. Using System Center Configuration Manager, you
no longer need to write scripts for deploying or capturing operating system images.
Additionally, by taking advantage of the Task Sequencer, the operating system
deployment process becomes completely hands-off.

Below are few links for more information on using System Center Configuration
Manager for operating system deployments:
e Overview of Operating System Deployment

http:/ /technet.microsoft.com/en-us/library/bb694101.aspx.

e How to Deploy Operating System Images to a Computer
http:/ /technet.microsoft.com/en-us/library/bb632559.aspx.

e How to Deploy an Operating System Image to a New Computer
Using Boot Media
http://technet.microsoft.com/en-us/library/bb694215.aspx.

e How to Deploy an Operating System Image to an Offline Computer
http:/ /technet.microsoft.com/en-us/library/bb681017.aspx.

e How to Create Stand-alone Media
http:/ /technet.microsoft.com/en-us/library/bb632784.aspx.

e How to Create a Computer Association for a Side-by-Side Migration
http:/ /technet.microsoft.com/en-us/library/bb680730.aspx.

e How to Configure the PXE Service Point
http:/ /technet.microsoft.com/en-us/library/bb680668.aspx.

e How to Deploy an Operating System Image using PXE
http://technet.microsoft.com/en-us/library/bb694069.aspx.

e Administrator Workflow: PXE Deployment
http://technet.microsoft.com/en-us/library/bb693705.aspx.

is subject to change without notice. The only warranties for HP products and services
are set forth in the express warranty statements accompanying such products and
services. Nothing herein should be construed as constituting an additional warranty. HP
shall not be liable for technical or editorial errors or omissions contained herein.
Microsoft and Windows are registered trademarks of Microsoft Corporation or its
subsidiaries in the United States and other countries.

652390001, March 2011

@ © 2011 Hewleti-Packard Development Company, L.P. The information contained herein
/

18


http://technet.microsoft.com/en-us/library/bb694101.aspx
http://technet.microsoft.com/en-us/library/bb632559.aspx
http://technet.microsoft.com/en-us/library/bb694215.aspx
http://technet.microsoft.com/en-us/library/bb681017.aspx
http://technet.microsoft.com/en-us/library/bb632784.aspx
http://technet.microsoft.com/en-us/library/bb680730.aspx
http://technet.microsoft.com/en-us/library/bb680668.aspx
http://technet.microsoft.com/en-us/library/bb694069.aspx
http://technet.microsoft.com/en-us/library/bb693705.aspx

	Executive Summary
	Introduction
	Benefits
	Prerequisites
	Software Requirements
	Deployment Using a Network
	Deployment Using Removable Media

	System Requirements
	Technician’s Computer
	Target Computer


	Deploying Microsoft Windows 7 over a Network
	Getting Started with the MDT 2010 Deployment Workbench
	Importing Operating Systems
	Importing Out-of-Box Drivers
	Create Task Sequences
	Additional Configurations
	Update Deployment Share and Create LiteTouchPE Disc
	Deployment Tasks

	Deploying Microsoft Windows 7 Using Removable Media
	Setup Windows Systems Image Manager
	Building an Answer File
	Validate and Save Settings
	Create a Configuration Set
	Deployment Tasks

	Tips and Best Practices
	MDT 2010 – Deployment Workbench
	WAIK – Windows SIM
	Driver Path
	LocalAccount
	ComputerName
	Troubleshooting Installation Issues

	Additional References


<?xml version="1.0" encoding="utf-§" ?>
- <unattend xmins="urn:schemas-microsoft-com:unattend":
<servicing /=
- «settings pass="windowsPE">
- =component name="Microsoft-Windows-Setup" processorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins:wem="http:/ /schemas.microsoft.com/WMIConfig/ 2002 /State" xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
- <DiskConfigurationz
«WillshowUI >Never</WillShowUI=
- «<Disk wecm:action="add">
<DiskID 0 </DiskID =
<WillwipeDisk>true</WillWipeDisk:>
- «<CreatePartitions >
- «CreatePartition wem:action="add">
<Order=1</Order=
<Extend>true</Extend:
<Type=Primary</Type:>
</CreatePartition>
</CreatePartitions =
</ Disk=
</DiskConfiguration=
- <UserDatax
<AcceptBulastrue</AcceptEulas
<FullName >Your Name</FullName >
=Organization:=Your Organization </Organization >
</UserDatax
<UseConfigurationSet>true</UseConfigurationSet:
<EnableMetwork =true </EnableNetwark>
<EnableFirewall>false</EnableFirewall>
- <Imagelnstall>
- «<0SImage>
- <InstallTo>
“DiskID=0</DiskID =
<PartitionID>2</PartitionID >
</InstallTo=
<InstallToAvailablePartition=false </InstallToAvailablePartition:=
<WillShowUI>Never</WillShowUI >
</0SImage:>
</Imagelnstall=
<Restart=Restart</Restart>
</component:
- <component name="Microsoft-Windows-International-Core-WinPE" processorArchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs'
xmins:wem="http:/ /schemas.microsoft.com/WMIConfig/2002/State" xmin "http:/ /www.w3.0org/2001/XMLSchema-instance":>
- <SetupUILanguage:
<UlLanguage>en-US</UlLanguage >
«WillshowUI >Never</WillShowUI=
</SetupUILanguage:
<InputlLocale»en-US</InputlLocalex
<SystemLocale »en-US</SystemLocales
<UILanguage =en-US</UlLanguage:=
<UlLanguageFallback»en-US</UlLanguageFallback>
<UserLocale>en-US</UserLocales
<layeredDriver=1</LayeredDrivers
</component:
</settings>

- «settings pass="specialize'>
- =zcomponent name="Microsoft-Windows-Shell-Setup" processorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScops="nonSxs"
xmin cm="http://schemas.microsoft.com/WMIConfig/2002/State" xmins:xsi="http:/ /www.w3.org/2001/XMLSchema-instance">
- <Autologonz
- <Password:=
=Value=P@sswOrd! </Valuex
<PlainText>True=/PlainText>
«/Password >
<Domain=Workgroup</Domain:
<Enabled>true</Enabled=
<LogonCount>1</LogonCount:
<lUsername=TestUser=/Username=
</AutoLogon=
- <Display =
<ColorDepth=32</ColorDepth=
<DPI»06</DPI=
<HorizontalResolution=1024 </HorizontalResolution =
<RefreshRate>60</RefreshRate>
<verticalResolution>768«</VerticalResolution=
</Display =
<TimeZone=Central Standard Time</TimeZone:=
<ComputerName>%serialNumber%o </ComputerlName=
<DisableAutoDaylightTimeSet>false </DisableAutoDaylightTimeSet>
<RegisteredOrganization =Your Organization </RegisteredOrganization=>
<RegisteredOwner=Your Organization</RegisteredOwner:
</components>
</settings>
- «settings pass="oobeSystem">
- <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScops="nonsxs"
xmins:wcm="http:/ /schemas.microsoft.com/WMIConfig/2002/State" xmins:xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance">
- <UserAccountsz
- <AdministratorPassword:>
<Value=P@ssword! </valuez
<PlainText>true</PlainText>
</AdministratorPassword =
- =LocalAccounts:
- <localAccount wem:action="add">
- «<Password>
<Value=P@ssword! </Value>
<PlainText>true</PlainText:=
</Password:>
«<Description>Test User</Description=>
<DisplayName>Test User</DisplayNamea:=
<Group>administrators</Group =
<NamesTestUser</Name>
</LocalAccount=
</LocalAccounts =
</UserAccounts=
- «OO0BE>
<HideEULAPage =true </HideEULAPage =
<HideWirelessSetupInOOBE >true </HidewirelessSetupInOOBE >
<NetworkLocation>Waork</MNetworkLocationz
<ProtectYourPC>1«/ProtectyourPCx
</00BE=>
<HideEULAPage >true </HideEULAPage >
<HideWirelessSetupInOOBE =true </HideWirelessSetupInOOBE =
<MetworkLocation=Work</NetworkLocation:
<Protect¥ourPCx1</ProtectYourPCx
</00BE>
<DisableAutoDaylightTimeSet=false </DisableAutoDaylightTimeSet:
<TimeZone:=Central Standard Time</TimeZone>
<RegisteredOrganization>Your Organization </RegisteredOrganization=
<RegisteredOwner=Your Organization</RegisteredOwners
=/component:
</settings=
- «settings pass="offlineServicing">
- =component name="Microsoft- Windows-PnpCustomizationsNonWinPE" processorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins n="http://schemas.microsoft.com/WMIConfig/2002/Stat nins:xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance":»
- <DriverPaths>
- <PathandCredentials wem:action="add" wcm:keyVvalue="1234567c"=>
<Path=%configsetroot% </Path>
«/PathAndCredentials >
</DriverPaths=
</component:
</settings>
<cpi:offlinelmage cpi:source="wim:file:/ /D/sources/install. wim#Windows 7 ENTERPRISE" xmiIns:cpi="urn:schemas-microsoft-com:cpi
<funattend:







<7?xml version="1.0" encoding="utf-8" 7=
- <unattend xmins="urn:schemas- microsoft-com:unattend"=
<servicing /=
- <settings pass="windowsPE":
- =component name="Microsoft-Windows-Setup" processorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins:wem="http:/ /schemas.microsoft.com/WMIConfig/2002/State" xmins:xsi="http:/ /www.w3.0org/2001/XMLSchema-instance"=
- <DiskConfiguration:=
=WillshowUI=Never</WillShowUIz
- <Disk wem:action="add"=>
<DisklD=0=/DiskID >
<WillwipeDisk =true </ WillWipeDisk =
- <CreatePartitions=
- =CreatePartition wcm:action="add">
<Extend>false</Extend:
=0rder=1</0rder>
<Size=2048</5ize
<Type=Primary</Type:>
«/CreatePartition=
- «CreatePartition wem:action="add">
=0rder=2</0rder>
<Extend>true</Extend>
<Type=Primary</Type:>
«/CreatePartition=
</CreatePartitions>
- <ModifyPartitions =
- <ModifyPartition wem:action="add">
<Format=NTFS</Format:
<Label=System_Recover</Label>
<Order>1</Order=
<PartitionID>1</PartitionID
<TypelD=0x27 </ TypelD:=
=/ModifyPartition:=
- =ModifyPartition wcm:action="add"»
<Format>NTFS</Format:
<Label>WINDOWS </Label>
<0rder=2</0Orders
<PartitionID =2 </PartitionID >
«/ModifyPartition=
</ModifyPartitions =
</Disk>
</DiskConfiguration:
- <UserData>
=AcceptEula=true</AcceptEulaz
<FullName>Your Name</FullName:
<0rganization=Your Organization</Organization:
</UserDataz
=UseConfigurationSet=true</UseConfigurationSet>
<EnableNetwork =true </EnableMetwork =
<EnableFirewall>false </EnableFirewall=
- «<Imagelnstall=
- «0sImage:
- <InstallTo>
=DiskID =0 </DiskID =
<PartitionID>2 </PartitionID=
</InstallTox
<InstallToAvailablePartition >false</InstalToAvailablePartition =
<WillShowUI =Never</WillShowUI =
</0SImage=
</Imagelnstall>
<Restart>Restart</Restart:
</component:
- =component name="Microsoft-Windows-International-Core-WinPE" pro
wmilns n="http:/ /schemas.microsoft.com/WMIConfig/2002/State
- «SetupUlLanguage =
<UILanguage =en-US</UlLanguage:>
zWillshowUI=Never </WillShowUI =
</SetupUILanguage=
<InputLocale =en-US</InputLocale:
<SystembLocale =en-US</SystemLocale
<UILanguage en-US</UlLanguage >
<UILanguageFallback>en-US</UILanguageFallback>
=UserLocale>en-US</UserLocale>
<LayeredDriver=1</LayeredDriver>
</component:
</settings:=
- «settings pass="specialize">
- <component name="Microsoft-Windows-Shell-Setup" processorarchitecture="x86" publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins:wem="http://schemas.microsoft.com/WMIConfig/2002/State" xmins:xsi="http:/ /www.w3.0rg/2001/XMLSchema-instance">
- <Autologon:=

cessorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonsxs"
"http:/ /www.w3.0org/2001/XMLSchema-instance":

semilns

<Value-P@sswrd! </Value >
<PlainText=True</PlainText:=
</Password=
<Domain=Workgroup </Domainz
<Enabled>true </Enabled=
<LogonCount=1</LogonCount:=
<Username=TestUser</Username:=
</AutolLogon:>
- <Display =
<ColorDepth»32</ColorDepthz
<DP1=96</DPI=>
<HorizontalResolution>1024 «</HorizontalResolutionz
<RefreshRate=60+</RefreshRate>
<VerticalResolution>768</VerticalResolution:=
</Display=>
<TimeZone>Central Standard Time</TimeZone:»
<Computerlame=OoserialNumber%o </ Computerflame =
<DisableAutoDaylightTimeSet=false</DisableAutoDaylightTimeSet:
<RegisteredOrganization>Your Organization</RegisteredOrganization=
<RegisteredOwner>Your Organization</RegisteredOwner>
</component:>
</settings>

- «<settings pass="specialize">
- =component name="Microsoft-Windows-Shell-Setup" processorarchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins:wcm="http:/ /schemas.microsoft.com/WMIConfig/ 2002 /State" xmins:xsi="http:/ /www.w3.0org/2001/XMLSchema-instance">
- <AutoLogon:
- <Password=
<Value=P@ssword! </Value>
<PlainText=True</PlainText:>
«/Passwordz>
<Domain=Weorkgroup</Domain:
<Enabled>true</Enabled=
<LogonCount=>1</LogonCount:=
<Username>TestUser</Usernamez
</AutolLogon:
- <Display>
<ColorDepth=32</ColorDepth=
«DP1=06</DPI=
<HorizontalResolution=1024 </HorizontalResolution:
<RefreshRate>60</RefreshRate >
<VerticalResolution>768</VerticalResolution:=
</Display >
<TimeZone=Central Standard Time</TimeZone>
«<ComputerName >%serialNumbero </ComputerName >
<DisableAutoDaylightTimeSet=false«/DisableAutoDaylightTimeSet:
<RegisteredOrganization=Your Organization </RegisteredOrganization>
<RegisteredOwner=Your Organization</RegisteredOwner=
</component>
</settings>
- =settings pass="oobeSystem":
- <component name="Microsoft-Windows-Shell-Setup" processorarchitectur
wmin cm="http:/ /schemas.microsoft.com/WMIConfig/2002/State" xi
- «UserAccounts
- <AdministratorPassword>
<Value=P@ssword! </Value =
<PlainText=true</PlainText>
<fAdministratorPassword>
- <localAccounts:
- <LocalAccount wem:action="add">
- <Password>
=Value=P@ssword! </Value=
“PlainText>true«/PlainText>
</Password>
«<Description>Test User</Description=
=DisplayName=Test User</DisplayName:=
«<Group =administrators</Group >
<Name>TestUser</Name >
«</LocalAccount>
</LocalAccounts:
</UserAccounts>
- <00BE:>
<HideEULAPage >true</HideEULAPage >
<Hidew 5552 tupInOOBE =true </Hide es55etupInOOBE >
<NetworkLocation=Work</NetworkLocation =
<ProtectYourPC>1</ProtectyourPC
</00BE>

"%86" publickeyToken="31bf3856ad364e35" [anguage="neutral" versionScope="nonSxs"

Ins:xsi="http:/ /www.w3.0rg/ 2001/ XMLSchema-instance">

<HideEULAPage>true </HideEULAPage >
<HideWirclessSetupInOOBE>true </HideWirelessSetupInOOBE >
<he kLocation=Work</NetworklLocations
<Protect¥ourPC=1</ProtectYourPC=
</00BE>
<DisableAutoDaylightTimeSet>false </DisableAutoDaylightTimeSets>
<TimeZone=>Central Standard Time</TimeZone»
<RegisteredOrganization=Your Organization</RegisteredOrganization>
<RegisteredOwner=Your Organization </RegisteredOwner>
</component:
<fsettings:
- <settings pass="offlineServicing">
- =component name icrosoft-Windows-PnpCustomizationsNonWinPE" processoraArchitecture="x86" publickeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxs"
xmins m="http:/ /schemas.microsoft.com/WMIConfig/2002/State" xmins:xsi="http://www.w3.org/2001/XMLSchema-instance":>
- <DriverPaths:z
- <PathandCredentials wem:action="add" wcm:keyValue="1234567c">
<Path=%configsetroot®b </Pathz
</PathandCredentials>
/DriverPaths=
</component:
<fsettings>
«<cpi:offlinelmage cpi:source="wim:file:/ /D/sources/install.wim#Windows 7 ENTERPRISE" xmlns:«
</unattend:

i="urn:schemas- microsoft-com:c






